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Your use of this document and the Sage product(s) described herein is governed by the terms and conditions of the Sage End
User License Agreement (“EULA”) or other agreement that is provided with or included in the Sage product. Nothing in this
document supplements, modifies or amends those terms and conditions. Except as expressly stated in those terms and
conditions, the information in this document is provided by Sage “AS IS” and Sage disclaims all express, implied or statutory
warranties of any kind, including but not limited to the warranties of merchantability, fitness for a particular purpose or of noninfringement. No implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves the
right to revise, supplement or remove information in this document at any time without notice to you or others.
Sage End User License: http://na.sage.com/sage-na/eula
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Chapter 1: Welcome to Sage 100 Contractor—
Canadian Edition Installation
Welcome to Sage 100 Contractor—Canadian Edition installation. Sage 100 Contractor can run in many different software and
network environments. Because of that, there are considerations you need to make as you prepare for installation. The more
you understand about the installation process and how it relates to your software and network environment, the more likely
your installation will proceed smoothly.

Other printed and printable guides

l

The user-assistance Help system

l

Contacts for Customer Support

l

Sage 100 Contractor training

l

Information about business partners.
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This chapter provides more information about customer resources, such as:

of

How to Read this Document
This document uses the following conventions:

The names of screens, windows, fields, and other features displayed by the software are shown in bold type.

l

Information you enter into the software is in bold type, as in the following example:
Enter Miscellaneous in the Amount Type box.

l

Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key names indicates
that you should press both keys at the same time; for example, SHIFT + TAB.

l

The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK] and [Post].

Th
ha is
s ve
be rs
en ion
re of
tir th
ed e
s

l

TIP: This symbol draws your attention to helpful information to make it easier for you to use Sage 100 Contractor.
NOTE: This symbol draws your attention to information of particular interest, such as information not included in steps.
CAUTION: This symbol draws your attention to information that is important because it can help you avoid a costly or
time-consuming error.
IMPORTANT: This symbol draws your attention to information that is of critical importance.
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Customer Support and Resources
Before you contact Customer Support
Before you decide to contact the customer support call center, be sure to take advantage of the resources available to you.
These services are available 24 hours a day, 7 days a week.

Sage 100 Contractor Help
From anywhere within the software, you can access this comprehensive library of easy-to-find topics to learn more about
specific procedures, topics, fields, or buttons.

Sage Knowledgebase

ar
e

Depending on your Sage service plan, we also offer a web-based Sage Knowledgebase and online user community forums at
www.sagecre.com or through the in-product menu. Our staff maintains an extensive knowledge database of questions and
answers covering everything from frequently asked questions to more complex problems and solutions. In addition, we keep all
product reference documentation available in the Knowledgebase. This online tool is the same tool we use in our customer
support call center to help answer your call.

To access the Technical Support Knowledgebase:
1 Click www.sagecre.com/customerlogon.

3 Complete Step 1 by selecting Sage 100 Contractor from the list of products.

of

4 Complete Step 2 by entering a search term in the box.
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2 On the Welcome page, in the left column, click Knowledgebase Search to open a list of products.
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5 Click Search. The search results appear below the box.

Sage 100 Contractor InfoCenter

Find Sage 100 Contractor software notices and all the information you need, such as industry news, products, services, new
enhancements, tips, training, special offers and more.
http://www.na.sage.com/sage-100-contractor/infocenter-news

Technical Documentation Available

A number of guides are included in the software. Access important release information such as system requirements, software
enhancements, quickly and easily. Click the Home & Resources tab > Printable Documentation or Resources > Printable
Documentation if you have Activity Centers hidden to see the available PDF files. You can also find the PDF files in the
Documentation folder in \Program Files (x86)\Sage\Sage 100 Contractor\.

Sage 100 Contractor Virtual Conference

Interact with and learn from Sage Construction and Real Estate senior leadership, product experts, and fellow customers
online. Get the latest information on product updates as well as network and share experiences with your peers. Check the
Sage 100 Contractor InfoCenter at http://www.na.sage.com/sage-100-contractor/infocenter-news for current virtual
conference information.

Contacting Customer Support

Contact Customer Support in the United States and Canada at:
Toll free: 800-866-8049
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Or 503-690-6775
www.sagecre.com

Hours of Operation
Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the exceptions listed below.
l

Every Thursday from 2 p.m. to 3 p.m. Pacific Time, closed for staff meetings.

l

Standard United States holidays.

l

Quarterly company meetings.

You can also submit your request for customer support online 24 hours a day, seven days a week by logging on to
www.sagecre.com/customerlogon. Our customer support team will reply to your questions during normal support hours.
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Any additional closures will be communicated by our regular customer email newsletters.
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When You Contact Customer Support
Depending on your Sage service plan, you may be able to contact the Sage Customer Support Call Center to work with one of
our highly trained customer support professionals. Before you call, be sure to have the following information on hand so we can
handle your call efficiently.

Question
What is your Sage client
ID number?

How to Find the Answer
Your client ID number can be found on correspondence you receive from Sage. If you do not
know your Sage client ID, please contact the person at your company who maintains your
relationship with Sage.

What software version are To find the version, open Sage 100 Contractor; click Help > About Sage 100 Conyou using?
tractor and note the number listed.
What application or area
On the menu list, identify the application and number where are you are work (i.e.
in the software are you callSelecting Invoices to Pay in 4-3-1, Accounts Payable Vendor Payments).
ing about?
Walk through the exact steps you completed with as much detail and accuracy as possible.

Is there an error message?

Write down the exact wording of the message.

Can you reproduce the
issue?

Were you able to walk through the same steps that led to the problem and see
whether it happened again?

of
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How can we help you?
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Is this the first time the
problem has happened?
Ask other users if they have experienced the same problem. Have them test at their
Does the problem occur
workstation to see if they experience the same problem. Also, have the original user
on one workstation or sev- try other workstations to see whether the problem is specific to that user.
eral?
Has anything changed
with your software, hardware, or workflow?

Ask your network administrator for technical information regarding anything that may
have changed behind the scenes: upgrades to Sage 100 Contractor, new third-party
software installations, moving of data from one server to another, new printers or print
driver installation, or anything else that might affect the network.

Does the problem happen Select [File> Open Company], then change the drive letter on the dropdown to C:,
in the sample data sets?
select Sample Company.
What kind of network are
you using?

What operating system is
on your computer?

If you do not know, please contact your network administrator.
For XP: Click [Start], click [Run], type winver and click [OK].
For Vista: Click [Start], type winver in the ‘start search’ window and click [OK].

What printers and print
drivers are installed?

If you do not know, please contact your network administrator.

When was your last
backup?

If you do not know, please contact your network administrator.
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Responding to You
Our goal is to answer all calls within the first three minutes, but more often than not we answer your call on the first ring! Once
calls are answered, our support analysts resolve over 90% of questions during the first contact.
Our analysts work with you to respond accordingly to the urgency of your issue. Call urgencies range from a simple explanation
of software settings to critical situations in which work is stopped or data integrity is compromised. Some calls may warrant
further research and followup, in which case our support analyst will place your call in his/her in-progress work list. At every
step of the way, we work with you to until a resolution or agreement can be reached.
Depending on your Sage Service plan, you may check the status or update, or even create a new support ticket online:
1 Visit www.sagecre.com.
2 Click the [Customer Support] button.
3 Logon to the Sage Customer Portal.
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4 Next, select the Support tab and choose the [Self Service] button.
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Training Resources
When you choose to take online classes from Sage or work with a Sage business partner, you will learn how to use Sage 100
Contractor to support your business. Contact your business partner to find out about training options or visit Sage University
at: https://sageu.csod.com.

Online Classes
Online classes help you maximize your use of Sage 100 Contractor. Online classes are a convenient training option for your
company and new users to learn more about Sage 100 Contractor so you can get the most out of the software. You can select
from classes on all aspects of Sage 100 Contractor, including project management, estimating, scheduling, service
management and payroll. Each online class is led by an instructor with years of experience using Sage 100 Contractor. During
the class, you will be able to follow along as the instructor demonstrates functions and workflows in Sage 100 Contractor. In
the online live session, you can ask questions and benefit from hearing answers to other students' questions.
For more information, visit https://sageu.csod.com.

Getting Started as a New User
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We recommend that all new users should begin with our New Customer Training (NCT) series, which is included in our
Essentials Training Package in recorded format for 24/7 access. If you prefer live online training led by an instructor, you can
register for the Realtime Learning version of these NCT courses. For more information, visit https://sageu.csod.com.

Business Partners

of

To serve you better, Sage 100 Contractor products and services are available to you through an authorized network of
business partners. Business partners have local expertise and regional knowledge working with contractors in the region.
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Your business partner is available to serve you, from simple how-to questions and hands-on demonstrations, to installation,
implementation, and training. They're fully equipped to help you get where you want to be. For more information, please contact
your Sage 100 Contractor business partner.

Business Forms

Sage 100 Contractor is designed to work with generic cheques and forms that are available from many sources. There is no
single vendor that customers must use; however, you can get a complete portfolio of forms, tax forms, and cheques through
Sage Construction and Real Estate Forms by calling 800-760-7929 or by visiting www.sagecreforms.biz.
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Chapter 2: System Requirements and
Configuration
Chapter 2, “System Requirements and Configuration,” presents technical information about:
l

System requirements for servers and client workstations

l

Supported operating systems

l

Special configurations for specific operating systems

Be sure your computers meet the system requirements before you install the software, as Sage 100 Contractor will not run
correctly or at all on computers that do not meet the minimum requirements.

ar
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This section provides information about system requirements along with general and specific configuration options.
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Hardware Requirements
Server hardware specifications
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We cannot recommend server hardware specifications for your network, as this depends on your specific requirements, such
as the number of users on your network, or other programs that might use server resources, such as firewalls, software
applications, mail systems, and so forth. We can, however, recommend a set of minimum hardware requirements.
NOTE: When you have a network with three or more users, a dedicated file server increases performance and reliability.

Server hardware requirements

The following table shows the operating systems that are supported for the server computers running Sage 100 Contractor.
NOTE: The minimum processor requirements for servers listed in the table below are based on the Microsoft®
Windows® Server 2003® operating system family. When updating or purchasing servers running newer operating
systems such as Windows Server 2012 Standard, Windows Server 2012 Essential, Windows Server 2008®, Small
Business Server® 2008, and Server 2008 R2 Standard, we recommend that you also refer to Microsoft system
requirements.
Hardware for Microsoft® Windows®
Server 2003®

Minimum

Recommended

Processor

Intel® Pentium® 4 or
comparable

Intel® Dual Core/Quad Core™ or
comparable, 2 GHz+

2 GB

4 GB+

Free Disk Space

3.5 GB

3.5 GB+

CD-ROM Drive

2X CD-ROM

24X CD-ROM+

Printers

For highest quality printing, we recommend laser or inkjet printers.

RAM

-7-

IMPORTANT: These minimum recommendations include the 600 MB required for running Microsoft .NET Framework
4.0 software. The recommended free disk space is based on the installation of a single program and the average size of a
Sage 100 Contractor company database. Allow at least 50 MB for each additional company database that you create.

Client and workstation hardware requirements
The following table shows the hardware requirements for client and workstation computers running Sage 100 Contractor.
Hardware

Minimum

Recommended
Intel Dual Core or comparable

Vista/Windows 7/Windows 8 processor

1 GHz

2 GHz+

RAM (except Vista/Windows 7/Windows 8)

1GB

2 GB+

Vista/Windows 7/Windows 8 workstation RAM

2 GB

4 GB+

Free Disk Space

1 GB

3 GB+

CD-ROM Drive

2X CD-ROM

2X CD-ROM+

Printers

For highest quality printing, we recommend laser or inkjet printers.

ar
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Processor (except Vista/Windows 7/Windows 8) Pentium 4 or comparable

of
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NOTE: These minimum recommendations include the 600 MB required for running Microsoft .NET Framework 4.0 on
client workstations. The recommended free disk space is based on the installation of a single program and the average
size of a Sage 100 Contractor company database. Allow at least 50 MB for each additional company database that you
create.
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Sage 100 Contractor now supports virtual server environments

In addition to the performance and cost savings benefits, virtualization is expected to be a commonly used technology going
forward in the construction industry. Please contact Customer Support if you are planning to run Sage 100 Contractor in a
virtual environment. Business partners are expected to configure and support the virtualization itself. For more information,
please contact your Sage 100 Contractor business partner.
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Operating Systems Requirements
Operating systems
Use one of the supported operating systems below for a smooth and successful installation experience.

Supported Operating Systems
Client/Workstation Operating Systems

Microsoft Windows Server 2012 Standard

Microsoft Windows 8 Enterprise

Microsoft Windows Server 2012 Essentials

Microsoft Windows 8 Professional

Microsoft Windows Small Business Server 2011®

Microsoft Windows 7 Ultimate

Microsoft Windows Server 2008 Enterprise Edition

Microsoft Windows 7 Enterprise

Microsoft Windows Server 2008 Standard Edition

Microsoft Windows 7 Professional

Microsoft Windows 2008® Small Business Server

Microsoft Windows Vista Ultimate

Microsoft Windows Server 2008® R2 Enterprise Edition

Microsoft Windows Vista Business

Microsoft Windows Server 2008® R2 Standard Edition

Microsoft Windows XP® Professional (32-bit, SP 2 or
newer)

Microsoft Windows Server 2003 Enterprise Edition

Microsoft Windows XP® Professional (64-bit, SP 3)

Microsoft Windows Server 2003 Standard Edition
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Microsoft Windows Server 2003 Small Business Server (SP 1 or
newer)
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Server Operating Systems

Microsoft Windows Server 2003 R2 Enterprise Edition
Microsoft Windows Server 2003 R2 Standard Edition

Microsoft Windows Server 2003 R2 Small Business Server

Unsupported Operating Systems

NOTE: Sage 100 Contractor and/or its components do not run on or do not support some operating systems. Do not
install Sage 100 Contractor to computers running these Microsoft Windows operating systems:
l

Apple operating system, any version

l

Microsoft Windows 95®

l

Microsoft Windows 98®

l

Microsoft Windows NT® Server

l

Microsoft Windows NT Workstation

l

Microsoft Windows 2000®

l

Microsoft Windows 2000 Server®

l

Microsoft Windows XP Home ®
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l

Microsoft Windows Vista Home Basic

l

Microsoft Windows Vista Home Premium
IMPORTANT: Microsoft .NET Framework 4 must be installed to all computers running Sage 100 Contractor and License
Administration. During installation, both Microsoft .NET Framework 3.5 Service Pack 1 and Microsoft .NET Framework 4
are installed on your computer automatically if they are not already installed. Be sure that all server and client computers
meet both .NET Framework requirements and Sage 100 Contractor requirements.

Web browser requirements
Web browser requirements and recommendations are:
Minimum
Microsoft Internet Explorer® 6.0, Service Pack 1 or later

Internet Access Required for Sage 100 Contractor

ar
e

Sage 100 Contractor features such as printing or efiling, submitting enhancement requests, or downloading periodic product or
tax updates all require Internet access. To take advantage of these features, please ensure any workstation or server that
Sage 100 Contractor is installed on has access to the Internet.
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During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the
Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage 100
Contractor is installed, then disconnect the Sage license server from the Internet.
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NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere. See
"Appendix A: System Requirements" for supported browsers in the Getting Started Guide at
http://help.sageconstructionanywhere.com/docs/Default.htm.

Supported Microsoft Office versions

The following table shows which versions of Microsoft Office are supported in Sage 100 Contractor.
NOTE: Support for Microsoft Office 2013 will be available in late 2013.
Supported Microsoft Office Versions

Microsoft Office 2003
Microsoft Office 2007
Microsoft Office 2010
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Network Configuration Requirements
Server network configuration requirements
The following table shows the server network configuration requirements for server computers running Sage 100 Contractor.
IMPORTANT: You must allow HTTPS outgoing traffic on port 443 to the outside Internet. This is a requirement of the
licensing and entitlement service and for Sage Construction Anywhere connectivity.
Process

Required

Network Protocol

TCP/IP

Minimum Network Speed - LAN

10/100/1000 Mbps

Minimum Network Speed - WAN

+/- 1.5 Mbps receiving data (downstream)
+/- 384 Kbps sending data (upstream)

ar
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NOTE: Sage 100 Contractor typically runs in a local area network (LAN) environment. Sage 100 Contractor can run in a
wide area network (WAN) using Citrix or Terminal Services. Contact your Sage business partner for more information.

Client and workstation hardware requirements

Minimum

Processor (except Vista/Windows 7/Windows 8) Pentium 4 or comparable

Recommended

of

Hardware

tw

The following table shows the hardware requirements for client and workstation computers running Sage 100 Contractor.

Intel Dual Core or comparable

1 GHz

2 GHz+

RAM (except Vista/Windows 7/Windows 8)

1GB

2 GB+

Vista/Windows 7/Windows 8 workstation RAM

2 GB

4 GB+

Free Disk Space

1 GB

3 GB+

CD-ROM Drive

2X CD-ROM

2X CD-ROM+

Printers

For highest quality printing, we recommend laser or inkjet printers.
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Vista/Windows 7/Windows 8 processor

NOTE: These minimum recommendations include the 600 MB required for running Microsoft .NET Framework 4.0 on
client workstations. The recommended free disk space is based on the installation of a single program and the average
size of a Sage 100 Contractor company database. Allow at least 50 MB for each additional company database that you
create.

About network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication
among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations can
potentially disable the communication:
l

File sharing on computers running the Windows 7, Vista, Server 2008, and Server 2008 R2 operating system must be
enabled. To enable file sharing, follow the instructions in the Windows 7/Vista/Server 2008 Help.

l

TCP communication requires the selection of port numbers that are not in use by other processes on the local computer.
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l

Software firewalls running on the local computer can be configured to block processes from opening TCP ports, which
will prevent communication through the TCP Remoting Channel.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured automatically to allow
the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you may need to
manually adjust some settings in the firewall in order to ensure proper operation.
You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100 Contractor
Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party firewall
products.

To configure the Windows Firewall:
1 Click Start > Control Panel > Security Center (XP) or Security (Vista/Server 2008) or System and Security (Windows
7).
2 Open Windows Firewall, and select the Exceptions tab (XP) or Allow a program or feature through Windows Firewall
(Vista, Windows 7, and Server 2008).

ar
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3 If Sage 100 Contractor Hosting Framework is not on the list, then you can add it by selecting Add Program, then browsing
to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

of
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NOTE: By default, the exception is set to allow access by any computer on the network. If desired, you can refine this
setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can cause the computer to
be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8 32-bit
C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\ProgramFiles\Sage\Sage 100 Contractor

l

C:ProgramData\Aatrix Software

l

C:\Program Files\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data
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Files to exclude when manually configuring your firewall for Windows 8 64-bit
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2003
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l

C:\MB7

l

C:ProgramFiles\Sage\Sage 100 Contractor

l

C:\Documents and Settings All Users\Application Data\Sage\Sage 100 Contractor

l

C:\Documents and Settings\All Users\application Data\Aatrix Software

l

C:\Program Files\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows XP 32-bit
C:\MB7

l

C:ProgramFiles\Sage\Sage 100 Contractor

l

C:\Documents and Settings All Users\Application Data\Sage\Sage 100 Contractor

l

C:\Documents and Settings\All Users\application Data\Aatrix Software

l

C:\Program Files\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

tw
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l

Files to exclude when manually configuring your firewall for Windows XP 64-bit
C:\MB7

l

C:\Documents and Settings\All Users\Application Data\Sage\Sage 100 Contractor

l

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Aatrix Software

l

C:\Documents and Settings\All Users\Application Data\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data
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l

Files to exclude when manually configuring your firewall for Windows Vista 32-bit
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\ProgramFiles\Sage\Sage 100 Contractor

l

C:ProgramData\Aatrix Software

l

C:\Program Files\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit
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l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\ProgramFiles\Sage\Sage 100 Contractor

l

C:ProgramData\Aatrix Software

l

C:\Program Files\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

tw

l
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Files to exclude when manually configuring your firewall for Windows 7 32-bit

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data
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Files to exclude when manually configuring your firewall for Windows 7 64-bit

Files to exclude when manually configuring your firewall for Windows Server 2008, 2011, 2012
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data
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Microsoft .NET Framework 4.0 Requirements
About installation and Microsoft .NET Framework
When you install Sage 100 Contractor software, you will also install the Microsoft .NET Framework 4.0, if it is not already
installed. It is important that you make sure that both your client and server computers meet the minimum requirements for
installing both Sage 100 Contractor software and Microsoft .NET Framework 4.0.
IMPORTANT: If the Sage 100 Contractor installation requires an installation of Microsoft .NET Framework 4.0, the Sage
100 Contractor installation process may continue automatically after the .NET Framework installation is completed. If
you are prompted to restart your computer after the .NET Framework installation, however, you must do it to continue the
Sage 100 Contractor installation.

About installing .NET Framework 4.0 and Operating Systems
NOTE: If Microsoft .NET Framework 4.0 is not already installed on your computers, then that installation alone may take
up to 20 minutes per computer.

ar
e

The following are the supported operating systems for .NET Framework 4.0:

Client/Workstation Operating Systems

Microsoft Windows Server 2012 Standard

Microsoft Windows 8 Enterprise

Microsoft Windows Server 2012 Essentials

Microsoft Windows 8 Professional

Microsoft Windows Small Business Server 2011®

Microsoft Windows 7 Ultimate

Microsoft Windows Server 2008 Enterprise Edition

Microsoft Windows 7 Enterprise
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of

tw

Server Operating Systems

Microsoft Windows Server 2008 Standard Edition

Microsoft Windows 7 Professional

Microsoft Windows 2008® Small Business Server

Microsoft Windows Vista Ultimate

Microsoft Windows Server 2008® R2 Enterprise Edition

Microsoft Windows Vista Business

Microsoft Windows Server 2008® R2 Standard Edition

Microsoft Windows XP® Professional (32-bit, SP 2 or
newer)

Microsoft Windows Server 2003 Enterprise Edition

Microsoft Windows XP® Professional (64-bit, SP 3)

Microsoft Windows Server 2003 Standard Edition

Microsoft Windows Server 2003 Small Business Server (SP 1 or
newer)
Microsoft Windows Server 2003 R2 Enterprise Edition
Microsoft Windows Server 2003 R2 Standard Edition

Microsoft Windows Server 2003 R2 Small Business Server

Viewing and verifying system information

For Windows XP and Windows 2003 Server, you may use the winmsd.exe to open the System Information window to view a
list of your system information.

To view and verify system information on Windows XP and Windows 2003 Server:
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1 Click [Start], the click [Run].
2 The [Run] dialog box opens.
3 In the [Open] text box, type winmsd.exe, and then press the Enter key.
The System Information window opens displaying a list of your system information.
For Windows Vista, Windows 7, and Windows 8, use MSinfo32.exe to open the System Information window to view a list of
your system information.

To view and verify system information on Windows Vista, Windows 7, and Windows 8:
1 Click [Start], then type [Run].
2 The [Run] dialog box opens.
3 In the [Open] text box, type MSinfo32.exe, and then press the Enter key.
The System Information window opens displaying a list of your system information.

.NET Framework Requirements for Server Computers

Hard disk space at installation

800 MB

Video card

800x600, 256 colors

tw

Required
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.NET Requirements for Client Computers

of

Component

ar
e

Minimum requirements for Microsoft .NET Framework 4.0 on servers

Minimum requirements for the Microsoft .NET Framework 4.0 on clients
Component

Required

Hard disk space at installation

600 MB

Video card

800x600, 256 colors
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Report Scheduling and Faxing Functionality
About setting up emailing and faxing through Sage 100 Contractor
Using the faxing functionality through the Sage 100 Contractor program requires:
l

Installation of the Windows operating system Fax Service component

l

A separate installation and setup of a fax modem in your workstation

l

Access to an analog phone line.

In addition, you will also have to set up the cover page information and the number of times that the fax re-tries to send.
For more information about installing and setting up your fax modem, refer to the documentation that came with your fax
modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.
For more information about installing the Windows operating system Fax Service component, see Installing the Window Fax
Services component.

ar
e

Upgrade to the latest version of Adobe Reader

Adobe Reader supports faxing from Windows. To fax from Sage 100 Contractor, you should download and install the latest
version from http://get.adobe.com/reader/.

tw

Disable automatic updating for Adobe Reader

of

If you are using the scheduling capability for sending faxes, we recommend that you disable the automatic “check for updates”
capability of Acrobat Reader as it will prevent scheduled reports from completing.
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NOTE: Instructions for disabling automatic “check for updates” differ from version to version of Adobe Reader. Refer to
the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

IMPORTANT: Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access to a simple mail
transfer protocol (SMTP) email server.
The Email Settings window provides a way for you to set up email. You can change the selections to accommodate different
emailing preferences.
You can access the Email Settings window through:
n

Any Report Printing window by clicking the Email button on the toolbar to open the Email Distribution windows.
Then, click the Email Settings button to open the Email Settings window.

n

7-9 Alerts Manager

n

Click on Settings in the Dispatch Board, then click on Email Setup.

Sage 100 Contractor and SMTP

IMPORTANT: The SMTP server may be located on your workstation PC, on a server on your company’s network, or at
your Internet service provider (ISP). If the email server is local, you may need the assistance of an IT professional to
properly identify or set up this capability. If the email server is located at your ISP, you may need contact your ISP for
assistance.
Using the ISP’s simple mail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically requires “user
authentication” at the STMP server. An example of an SMTP email server name is smtp.att.sbcglobal.net.
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Different ISPs may use different terms when referring to user authentication. In general, however, user authentication means
verifying a user’s identity by means of a “user name” and “password.”
In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication only refers to
verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:
l

Sage 100 Contractor user name and password

l

Network domain user name and password

l

Windows system user name and password.
NOTE: We do not provide support for setting up or installing an email server. You set up user authentication and your fax
line access dial out number on 7-2 Company Information.

Installing the Windows Fax Services component
To fax from Sage 100 Contractor, you must install the Windows Fax Services component.

To install the Window Fax Services component (XP):

ar
e

1 Open the Window Control Panel.
2 On the Control Panel window, double-click Add or Remove Programs.

3 On the Add or Remove Programs window in the left column, click the Add/Remove Windows Components icon.

tw

4 On the Windows Components Wizard window, select the Fax Services check box, and clear all the other check boxes.

To install the Window Fax Services component (Vista):

of

5 Click Next, and follow the instructions on the screen.
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1 Click Start > Control Panel > Programs > Turn Windows features on or off.

2 On the Windows Features window, locate the Windows fax and scan check box, then select it.
3 Click [OK].

To install the Window Fax Services component (Windows 7):

1 Click Start > Control Panel > Programs > Turn Windows features on or off.

2 On the Windows Features window, locate Print and Document Services, then click on the Windows fax and scan
check box.
3 Click [OK].
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Chapter 3: Sage 100 Contractor Installation
This chapter provides detailed information and instructions for installing Sage 100 Contractor software in different
environments, such as:
l

Single user

l

Peer-to-peer

l

Network

Pre-installation information for new customers

ar
e

Implementing and running your business in Sage 100 Contractor must be thoroughly planned out in advance to harness the
power of this software. Your existing company data must be migrated before you start working in the program. Your business
partner can assist you with a data migration and business implementation plan. For more information about implementing Sage
100 Contractor for your company, see the information about business partners in Chapter 1 of this guide.

tw

We recommend that you take full advantage of all the knowledge and advice found in Sage 100 Contractor documentation and
training classes. We also recommend that you work with your business partner and accounting professionals before you begin
to implement this software for your business.
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of

IMPORTANT: We recommend that you install the Sage license server on a computer that is always available to other
computers on your network that are running Sage 100 Contractor.

Pre-installation information for existing customers

Because existing customers are working with company information and possibly with scheduled reports, please review these
important points before you start to install the program.
NOTE: Before you install, make at least one backup copy, but consider making two backup copies of your existing
company data for an extra margin of safety.

Duration of the installation process

Plan on at least five and possibly up to 20 minutes per computer to install Sage 100 Contractor. The duration of the Sage 100
Contractor installation depends a great deal upon each computer’s configuration. For example, some newer computers are preinstalled with essential software required to run Sage 100 Contractor software such as the .NET Framework 3.5 Service Pack
1. Installation to older computers may take more time.

Additional required software

Microsoft .NET Framework 4.0 must be installed on all computers running Sage 100 Contractor software. The installer
determines if the .NET Framework 4.0 is already installed. If not, the installer installs the required software automatically.
Plan for an additional 20 minutes per computer to install .NET Framework 4.0.

NOTE: It is very important that you understand the network environments and operating systems on the computers and
server computers where you install Sage 100 Contractor software. Chapter 8 Special Configurations provides detailed
information about installing to different environments.
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About installing the Sage 100 Contractor software to different configurations
You can install Sage 100 Contractor software to many different configurations, for example, stand-alone, network server, Citrix
and Terminal Services servers, peer-to-peer, and workstations.
IMPORTANT: The optimal operational size of a peer-to-peer network running Sage 100 Contractor is two to five
workstations. Additional workstations may adversely impact Sage 100 Contractor response times. Networks consisting
of more than five (5) workstations may need to use one computer as a dedicated server.
Sage 100 Contractor allows users to share data and reports stored on a network hard drive. From different workstations, users
can then access the server to share one set of data, one set of reports, and one set of report forms.
During installation, the installer checks for the components necessary to run Sage 100 Contractor and then copies the program
modules and reports to the \MB7 folder and subfolders that are created on the hard disk. In addition, the installation process
copies system files necessary for program operations to the Windows and Windows System folders.

ar
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The installation process does not make any configuration changes to the computer. After installation is complete, you must
configure the stand-alone computer, server computer, or workstation for optimal performance. For example, you need to
configure the date format on computers running the Windows Server 2003 operating system. For detailed information about
configuring each server and workstation depending on its operating system, see Chapter 8, Special Configurations.

Connectivity across your network

of

tw

For client workstations to be able to run Sage 100 Contractor, they must all be connected to the Sage license server. If one
user sees the “Sage 100 Contractor can’t communicate with the designated Sage license server” message when all other
people are connected, then you know that the connectivity problem is limited to that one person. If you encounter a hardware
failure with your license server, then no one will be able to run Sage 100 Contractor.

Th
ha is
s ve
be rs
en ion
re of
tir th
ed e
s

Installing the Sample Company

The Sample Company provides the means for viewing and working with sample data in Sage 100 Contractor windows. There
are sample accounts, sample employees, sample takeoffs, and much more. By viewing and working with this sample data,
you can gain an understanding of how different windows interact with the sample data when managing a construction business
with Sage 100 Contractor.
Sage 100 Contractor master trainers use the Sample Company extensively during Sage 100 Contractor training classes. We
highly recommend that you load the Sample Company during your initial installation.
You can log on to the Sample Company using “Supervisor” as the user name. You do not need a password.
The Sample Company:
l

Allows you a safe way to try out new functions as you learn them.

l

Is used in many online and recorded classes.

l

Provides samples of many Sage 100 Contractor forms that are all filled in. This makes it easy to understand many
concepts.

l

Provides starter lists for many values you'll need to set up: cost codes, cost types, tasks, client status, client type,
employee positions, paygroups, etc.

l

Provides you with live data to investigate the content of Sage 100 Contractor reports.

l

Takes very little space on your hard disk drive.

Installing the Sample Company overwrites any previous installations of the Sample Company. If you have made changes in
your Sample Company that you wish to keep, rename this folder before installing a fresh copy of the Sample Company.
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New Installations
A new installation is defined as installing the software on a computer that has never had Sage 100 Contractor installed on it
before.
NOTE: Instructions for reinstallation/upgrade installation over an existing installation are different. See Upgrade Preinstallation.
You must designate one computer on your network as the Sage license server. This server will manage use of Sage 100
Contractor; for example, the number of people who can use Sage 100 Contractor simultaneously on your network. You will
need to install the software on this computer first and then activate your licenses before installing Sage 100 Contractor on your
other computers.
Copy the entire CD (all files and folder) to a folder that you create on a network drive and then install to each client workstation
by launching the installation from that network folder from that client workstation. We recommend that you install to the Sage
license server computer first. Then when you install the program to your workstations, you can set up Sage 100 Contractor to
find the Sage license server and run the program using your license.

ar
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The installation process also presents different installation windows depending on whether you are installing Sage 100
Contractor as the Sage license server or you are just installing Sage 100 Contractor by itself.

Basic steps for new installations are:

2 Next, activate your licenses.
3 Install the program to all client workstations on your network.
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4 From each client workstation, specify the Sage license server.

of

tw

1 First install the program on your network server, the computer where all your company data is located. You do this only once
on your network. Remember to write down the Sage license server computer’s IP Address and/or computer name, which is
displayed at the end of the installation.

IMPORTANT: Always start installing the program at the computer that will be your Sage license server, which is likely to
be your network server.

Installing Sage 100 Contractor on the Sage license server

Use these instructions when installing the software on the computer you’ll use as the Sage license server or if you are running
in a stand-alone environment. Stand-alone means that you are running Sage 100 Contractor on one computer, or you are not
networking with other computers running Sage 100 Contractor.

To install from a download package unzipped into a local or shared folder:
1 Close all open programs except for firewall and anti-virus programs.

2 Browse to the drive and folder where you downloaded and extracted the software package.
3 In the folder, locate the setup.exe file and double-click it.

4 On the installation option window, select the option This computer will be my Sage license server, and click [Next].
5 On license agreement window, read the License Agreement carefully.

6 Select the check box to accept the terms, then click [Next]to continue the installation.
7 The select a drive window appears.

IMPORTANT: Sage 100 Contractor should always be installed to a local drive. You can share Sage 100 Contractor data
that is located on a network drive among client workstations that are running Sage 100 Contractor locally.
8 Select a local drive location for the installation, and click [Next].
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9 In the next installation window, you are presented with either one option or two options.
10 On the select additional options window, select the option Install the Sample Company for training purposes. We
recommend that you install the Sample Company.
11 Click [Next].
NOTE: The installer begins the installation process. It checks to see if the computer has .NET Framework 4.0 installed. If
this program is not found, the installer installs it.
12 At the end of the installation process, a confirmation window appears containing a list of installed programs.
l

Sage 100 Contractor

l

License Administration for Sage 100 Contractor

13 This window also displays the computer’s IP Address and its network name. You will use this information to specify the
Sage license server.
14 Review the list of installed programs, and write down the IP Address and network name of the computer.

ar
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IMPORTANT: Write down and keep the Sage license server computer’s IP Address and name in a convenient location.
To select the Sage license server from client computers running Sage 100 Contractor, you need to select its name from a
list or type the computer’s IP Address or name in a text box.
15 Click [Next].

tw

16 The activate your product licenses window appears. The Launch the License Administration program check box is preselected to launch the License Administration program so you can activate your licenses.

of

17 Read the instructions about activating your product licenses, and then click Finish, leaving the Launch the License
Administration program check box selected.
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NOTE: For information about this process, press F1 on the main License Administration window.

NOTE: When Sage 100 Contractor in installed, an icon labeled License Administration is placed in the Start >
Programs > Sage 100 Contractor menu of Windows and a file named Sage.SMB.LicenseAdministration.exe in the
MB7/Programs folder to provide you with the convenience and ability to view license information or update license
information for your provisioned license server while on a machine other than the provisioned license server. You can
provision additional licenses you have recently acquired to the actual license server machine without having to be present
at the actual license server.
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Installing Sage 100 Contractor on client workstations
NOTE: If the install program does not start automatically, go to Start > Run > Browse. Locate your CD drive or CD
image folder, select setup.exe, and then click OK. If your computer security warns you that Sage Licensing is trying to
access the Internet, click Allow.

To install Sage 100 Contractor only from a download package unzipped into a local or shared folder:
1 Close all open programs except for firewall and anti-virus programs.
2 Browse to the drive and folder where you downloaded and extracted the software package.
3 In the folder, locate the setup.exe file and double-click it.
4 Read the instructions on the installation welcome window, and click [Next].
5 On the installation option window, select the option This computer will run Sage 100 Contractor only, and click [Next].
6 On the license agreement window, read the License Agreement carefully.
7 Select the check box to accept the terms, then click [Next] to continue the installation.

ar
e

8 The select a drive window appears.
9 Select a local drive location for the installation, and click [Next].

tw

10 The installer begins the installation process. It checks to see if the computer has .NET Framework 4.0. If this program is not
found, the installer installs it.
11 Install the Sample Company for training purposes. We recommend that you install the Sample Company.

of

12 An installation complete window appears. The Launch Sage 100 Contractor check box is preselected so that you can
launch Sage 100 Contractor and specify the Sage license server.
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13 Read the important message and follow the instructions to launch Sage 100 Contractor.
14 Click [Finish].

15 Sage 100 Contractor begins its launch process by displaying the Specify Sage License Server window.
NOTE: When Sage 100 Contractor in installed, an icon labeled License Administration is placed in the Start >
Programs > Sage 100 Contractor menu of Windows and a file named Sage.SMB.LicenseAdministration.exe in the
\Program Files (x86)\Sage\Sage 100 Contractor folder to provide you with the convenience and ability to view license
information or update license information for your provisioned license server while on a machine other than the
provisioned license server. You can provision additional licenses you have recently acquired to the actual license server
machine without having to be present at the actual license server.
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Upgrade Installations
If you currently have Sage 100 Contractor installed on your network computers and you are going to reinstall it, you could be
either upgrading or updating the software.
Upgrade installations involve major changes, enhancements, and fixes to many parts of the program or to modules such as
licensing. For example, installing Version 19 over Version 18 is an upgrade installation because there are major enhancements
to the program.
Update installations, in contrast, usually involve changes to specific files, such as the Sage.SMB.PayrollTax.dll file and report
forms. These files can be changed and updated without any changes to major parts of the program.
In addition, upgrade installations are different from new installations. During new installations (or reinstallation after completely
removing Sage 100 Contractor and Sage licensing), you can designate a computer to be either the Sage license server or a
client workstation.

Upgrade Pre-installation

ar
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Upgrading your Sage 100 Contractor software requires that you complete preliminary tasks to ensure the safety of your
company data.

The following are steps to take before upgrading Sage 100 Contractor:

tw

When upgrading, it is important that you choose a block of time when you can install the upgrade to all the computers in your
office beginning with your Sage license server. Depending on your computer’s hardware and your network configuration, plan
on 15 minutes per computer for the installation process alone. Additional tasks may take extra time.

of

1 Make two backups of your company data. We suggest making two backups in case one of them is incomplete, becomes
corrupted, or is lost.
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2 Exit Sage 100 Contractor and all other programs - You must not install the Sage 100 Contractor upgrade when either Sage
100 Contractor or the Sage 100 Contractor API are running. We recommend that you shut down all other programs when
installing Sage 100 Contractor, but you do not have to shut down firewall and anti-virus software.
3 Locate the computer on your network that is your Sage license server, and begin the upgrade installation there.

Upgrade Installation

Always begin all installations at the computer that is the Sage license server. After installing the upgrade to the Sage license
server, install the upgrade to your workstations from the image placed in a folder on the network. For example, if you want to
install Sage 100 Contractor to a network drive, you have to go to that computer and install the program from there.
Sage 100 Contractor running on client workstations needs to connect to the Sage license server to access your company data.
If you do not change the designation of any computers on your network during an upgrade installation, all client workstations
will be able to locate the existing Sage license server again after installation.

Installing the upgrade

When installing, use the same upgrade installation steps for both your Sage license server and your workstation computers.
IMPORTANT: Install the upgrade to the existing Sage license server computer first. Install the upgrade to all
workstations only after the license server installation has been completed.

To install the upgrade from a download package unzipped into a local or shared folder:
1 Shut down Sage 100 Contractor and all open programs except for firewall and antivirus programs.
2 Browse to the drive and folder where you extracted the upgrade files in the steps above.
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3 Before you proceed further with installation, we recommend that you double-click the ReleaseNotes.pdf to open it in your
PDF viewer. It’s a good idea to review the Release Notes for information about “Enhancements,” “Fixes,” and “Known
issues and Comments” that might apply to your network configuration and/or operating systems and affect your upgrade
installation.
4 Double-click Setup.exe to begin the installation.
a If you are running the Windows XP operating system and you get a message advising you that the program publisher
cannot be identified, click [Run].
b If you get a message asking if you want to allow the following program to make changes to this computer, click [Yes].
5 On the welcome window, notice that a previous installation has been found, and click [Next].
6 On the installation option window, select an option, and click [Next]:
a This computer will be my Sage license server
b This computer will run Sage 100 Contractor only
7 On license agreement window, read the license agreement carefully.
8 Select the check box to accept the terms, and then click [Next].

ar
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9 On the select additional options window, select the option to install the Sample Company. We recommend that you install
the Sample Company, which is used extensively in Sage 100 Contractor training classes.

of

tw

IMPORTANT: The upgrade installation overwrites the existing Sample Company. If you want to save changes to the
existing Sample Company, clear the check box. If you do not overwrite the Sample Company, you must rebuild the
indexes in the Sample Company database using 7-4 Rebuild Indexes after the upgrade installation. If you have made
changes in your Sample Company that you wish to keep, rename this folder before installing a fresh copy of the Sample
Company.
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10 Click [Next]. The installation proceeds.

11 On the Installation complete window, click [Finish] to launch Sage 100 Contractor.
12 Repeat steps to upgrade all other computers running Sage 100 Contractor.

13 Follow the instructions for post-installation tasks to rebuild the indexes your company database from one computer and
reschedule your reports, as necessary.

Uninstalling Sage 100 Contractor from a Sage license server
When Sage 100 Contractor is uninstalled from an active license server, the server’s licenses are deauthorized and made
available to be acquired by another license server. If the Sage license server crashes and the licenses are not deauthorized,
contact Customer Support to have the licenses unlocked.
If uninstalling and then reinstalling to a Sage license server, the licenses need to be reactivated after reinstallation.
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Chapter 4: Sage ACT! Plug-in Installation
This chapter provides information and instructions for installing the Sage ACT! plug-in for use with Sage 100 Contractor.

Pre-installation information
In order for Sage 100 Contractor to integrate with Sage ACT!, the following requirements must be met:
n

Sage 100 Contractor 2013 Version 18.1 or later must be installed

n

Sage ACT! Premium or Sage ACT! PRO (version 2011 or later) must be installed

n

Sage ACT! plug-in license use must be obtained

ar
e

Duration of the installation process

tw

Plan on at least five to ten minutes per computer to install the Sage ACT! plug-in. The duration of the Sage 100 Contractor
installation depends a great deal upon each computer’s configuration. Installation to older computers may take more time.

of

Additional required software
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Sage ACT! Premium or Sage ACT! PRO (version 2011 or later) must be installed on all computers running Sage 100
Contractor software that use the Sage ACT! plug-in.
Plan for an additional 10 to 15 minutes per computer to install Sage ACT! Premium or Sage ACT! PRO.
NOTE: It is very important that you understand the network environments and operating systems on the computers and
server computers where you install Sage 100 Contractor software. Chapter 6 Special Configurations provides detailed
information about installing to different environments.

Installing the Sage ACT! plug-in
Basic steps for installation are:

1 Verify Sage 100 Contractor and Sage ACT! Premium or Sage ACT! Pro (version 2011 and later) are already installed.
2 Activate your Sage ACT! plug-in license.

3 Install the Sage ACT! plug-in on any client workstations where you use Sage ACT!.

Installation of Sage 100 Contractor and Sage ACT!

To install Sage 100 Contractor, refer to “Chapter 3: Sage 100 Contractor Installation” in this document.
To install Sage ACT!, refer to the installation instructions that came with Sage ACT! Premium or Sage ACT! PRO (version
2011 or later) and see the Sage ACT! Getting Started Resource Center at http://na.sage.com/Sage-ACT/support/GettingStarted.

Activate your Sage ACT! plug-in license use

To activate your Sage ACT! plug-in license, refer to “Chapter 6: Managing Your License” in this document.
- 26 -

To install the Sage ACT! plug-in on client workstations:
1 Close all open programs except for firewall and antivirus programs.
2 Browse to the drive containing Sage 100 Contractor and go to the MB7\Programs\Plug-ins folder.
3 Double-click on the ACTPluginSetup.exe to begin the installation.
4 On the welcome window, click [Next].
5 On the Installation complete window, click [Finish].
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tw

ar
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6 Restart computer as necessary.
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Chapter 5: Sage Construction Anywhere
Installation
This chapter provides information about setting up Sage 100 Contractor for use with Sage Construction Anywhere.

Additional required software
The Sage Construction Anywhere Connector should be installed on all computers running Sage 100 Contractor
software that connect to Sage Construction Anywhere, but can also be installed to a separate server. See the "Installing
the Sage Construction Anywhere Connector Software section in the Getting Started Guide at
http://help.sageconstructionanywhere.com/docs/Default.htm. The Sage Construction Anywhere Connector connects
your back office software to your Sage Construction Anywhere site. The connector installation includes the Sage
Construction Anywhere Connector software and its required prerequisite software.

l

An Internet connection using a compatible web browser. See "Appendix A: System Requirements" for supported
browsers in the Getting Started Guide at http://help.sageconstructionanywhere.com/docs/Default.htm.

ar
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l

of

Duration of the installation process

tw

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere.
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Plan on at least five to ten minutes per computer to install the Sage Construction Anywhere Connector software. The duration
of the Sage 100 Contractor installation depends a great deal upon each computer’s configuration. Installation to older
computers may take more time.

Pre-installation information

In order for Sage 100 Contractor to integrate with Sage Construction Anywhere, the following programs must be installed and
set up:
n

Sage 100 Contractor 2013 Version 18.3 or later must be installed

n

Supported version of Sage Construction Anywhere

For more information on Sage Construction Anywhere and the Sage software versions supported, do the following:
1 Go to http://help.sageconstructionanywhere.com/docs/Default.htm.
2 Click on the Getting Started Guide link.

3 View Appendix A: System Requirements for the currently supported software versions.

Setting up Sage Construction Anywhere Integration

In order for Sage 100 Contractor to integrate with Sage Construction Anywhere, the following programs must be installed and
set up:
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l

Sage 100 Contractor 2013 Version 18.3 or later must be installed

l

Supported version of Sage Construction Anywhere

In addition, an API user needs to be set up for any companies that are to be integrated.
l

In Sage 100 Contractor, in 7-3-1 Security Groups, an API security group must exist with the appropriate save
permissions. See See "Setting up an API security group and an API user in Sage 100 Contractor" on page 29 to set up
the API group.

l

In Sage 100 Contractor, in 7-3-2 User List, a user that is a member of the API group must be set up.

Setting up an API security group and an API user in Sage 100
Contractor

Group# (User input is required to save the record.)

l

Group Name (User input is required to save the record.)

l

Save

l

Delete

l

Void

l

Chg Period

l

Print Cheques

l

Notes
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Security groups let you control users’ ability to open windows as well as perform specific actions within a window. The 7-3-1
Security Groups window in Sage 100 Contractor contains a grid with numbered rows on the left and eight columns:

When you set up user groups, you type a group number and group name. Then you determine whether or not that group will
have rights to Save, Delete, and Void records, as well as to change the accounting period and print cheques. You may use the
Notes column to add any pertinent information about each group.
You must create an API security group that is named exactly API. At least one user must be added to the API security group.
You have to set rights to save, void, etc.
IMPORTANT: If you use security groups for the tasks performed by the employee in Sage 100 Contractor, make sure
the Sage Construction Anywhere user has access to all areas of Sage 100 Contractor.

To set up a security group for using the API
1 Open 7-3-1 Security Groups.

2 In the Group# cell, type a group number, such as 51.

3 In the Group Name cell, type API and do the following:

IMPORTANT: The API security group must be named exactly API.

a In the Save, Delete, Void, Chg Period, and Print Cheques cells, type Yes.

b To store information that may be relevant or important to that specific group, type a note in the Notes cell.
4 On the File menu, click Save.
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TIPS:
l

Before you can use the API security group to access Sage 100 Contractor company data, you have to assign a
user to the API security group.

l

Security is set up for each individual company, not for the entire program. Each company can use different user
names and passwords. If you have more than one company, you have to set up passwords for multiple
companies.

Then you have to assign a user to the API security group using 7-3-2 User List.
The 7-3-2 User List window controls major features dealing with users and program security.
NOTE: The user name and password created are for administrative use only. This information is for use by the Sage
Construction Anywhere Connector program only, and is not needed by the individual employee(s) using Sage
Construction Anywhere.

To assign a new user to the API security group
1 Open 7-3-2 User List.

3 In the Password cell, enter a password.
4 In the Group 1 cell, click once in the cell, and from the drop-down list, select the API group.

To assign an existing user to the API security group
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1 Open 7-3-2 User List.

of

IMPORTANT: The API will not accept “supervisor” as a user name.

tw

5 Click File > Save.

ar
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2 In the User Name cell, enter a user name, such as SCAUser.

2 Find the User Name for the person who will use Sage Construction Anywhere.

3 In the Group 1, Group 2, Group 3, Group 4, or Group 5 cell, click once in the cell, and from the drop-down list, select the
API group.
4 Click File > Save.
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Chapter 6: Managing Your License
This chapter provides detailed information about:
l

Managing and activating your license

l

Using License Administration

License Administration

ar
e

When you purchase Sage 100 Contractor software, it includes the License Administration program. Using the License
Administration program, you can activate licenses and monitor the license uses. During software installation, the License
Administration program is automatically installed on the computer that the software installer designates as the Sage license
server.
IMPORTANT: Before you can use Sage 100 Contractor with your activated license, you have to specify the computer
on your network that is the Sage license server when you launch Sage 100 Contractor.

tw

Where is the Sage license server located?
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The Sage license server is software running on a computer on your network that manages the Sage 100 Contractor products
and features that you purchased. Products and features can be a “core product,” additional “modules,” and a number of “license
uses.” The computers running your Sage 100 Contractor have to be connected to the computer running the Sage license server
so that the correct products, features, and number of license uses are available to you.

License Administration window

Use this window to view and maintain your licensing information. This includes the number of license uses, the users who are
logged on to Sage 100 Contractor, and licensing events.
Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The licenses give you
access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license
server automatically updates this information in your system. You can also select to update the licensing information from
Sage on demand.

About managing licenses

Use the License Administration window to activate licenses and monitor license uses.

Activating licenses

In order to use Sage 100 Contractor, you have to activate your product licenses.

To activate your license:

1 On the License Administration window, click the Edit registration info link.
2 Enter your Sage client ID.

3 Enter your Registration name.
4 Click [OK].
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License Information tab
The tab, which is available from the License Administration window, displays information about your Sage 100 Contractor
licenses.

Items on this tab
Item

Notes

Support plan
The date on which your support plan with Sage Customer Support expires.
expiration date

Last license
information
update

Displays the number of times the request for licenses failed in the past three months because
there were not enough licenses available. If there are a significant number of requests, you may
want to acquire additional licenses.

The last date upon which your licenses were verified with Sage's license server.

ar
e

Number of
requests
which
exceeded use
count (last 90
days)

NOTE: If your system cannot connect to Sage for a period of more than 10 days, you will receive a message
indicating there is a connection problem. See Troubleshooting license activation issues for more information.

Inventory

l

Service Receivables

l

Estimating

l

Document Control

l

Equipment Management
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Licensed modules

l

of

tw

Displays a list of licenses available to this server, based on the products you have purchased from Sage.
When you purchase new products, the licenses for those products become available to activate here.
"Canadian Edition" refers to the basic program, exclusive of the additional modules. The module licenses
that are not part of the core Canadian Edition, but are available for purchase, are listed here:

There is also a column that shows how many Canadian Edition licenses are checked out from this license
server to local machines.

Click to update the license information manually. This connects your server to the Sage license server,
where your current license information is stored, and it updates the information on this window. This also
Update license creates entries in the event log. View the event log to monitor the success of your license activations.

information

Deauthorize
license server

Multi-server
licensing

NOTE: If you are using multi-server license administration, ensure you have the proper allocations set
under Multi-server licensing before you update your license information.

Typically, this would be used if you are moving Sage 100 Contractor's license server from one machine to
another machine.
IMPORTANT: You need to deauthorize the old server in the License Information tab before you
authorize Sage 100 Contractor's license server on a new server.

This allows you to allocate your Sage licenses to multiple servers. For example, this could happen
if you have several corporate offices and want to use separate licenses for each office or if you
want to reserve a certain quantity of license uses for a specific group of people.
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Active Users tab
This tab of the License Administration window lists the names of all users and computers currently using Sage 100 Contractor.
Each row in the list represents a separate license use. If you find you are running out of licenses, you can review this list to
determine if any licenses can be made available. To make a license available, simply close Sage 100 Contractor on one of the
computers where the program is running.
You can restrict all users from logging on to the Sage 100 Contractor software from this tab.

Items on this tab
Item

Notes

User

The name of the user who is currently logged on to Sage 100 Contractor.

Computer

The computer where the user is logged on to Sage 100 Contractor.

Session

The Windows session for the user.
Click Restrict logon to prevent users from logging on to Sage 100 Contractor temporarily. This prevents new

ar
e

Restrict
users from logging on to Sage 100 Contractor but does not remove existing users. You might use this feature
logon/Allow in preparation for backing up your database, for example.
logon

tw

If you have previously restricted logon, click Allow logon to allow users to log on to Sage 100 Contractor.

Event log tab
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Use this tab of the License Administration window to view events related to licensing. This lists whether license validation was
successful or if there were any problems attempting to validate the licenses. See Troubleshooting license activation issues for
more information about issues validating licenses.

Items on this tab
Item
Level
Date and
time

Notes

The level of the licensing event (for example, informational).
The date and time that the licensing event occurred.

The description of the licensing event. Typically, this displays "Entitlements updated for client," but
Description this will also indicate if there was a problem updating the licenses. The section below this area provides additional details about the issue.
Clear
event log

Click to remove all entries in the list.
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Maintaining License Information
Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The licenses give you
access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license
server automatically updates this information in your system. You can also select to update the licensing information manually.
NOTE: Licenses are granted to the specific computer where the licenses were initially activated. If you
need to move your Sage 100 Contractor server to a different server, you must first deactivate the licenses
in the License Information tab on the old server before you can activate them on a new server.

To view or change license information:
1. Select License Administration program.
2. You can view or change the information here, or you can click Update license information to retrieve current licensing
information from Sage. Note that the Sage client ID and Registration name must match Sage's records exactly in
order for the update to be successful. To change the Sage client ID or the registration name, select Edit registration
information.

3. To view which users are logged on to Sage 100 Contractor, click the Active users tab.

ar
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NOTE: If you have multiple servers serving your Sage 100 Contractor application, click Multi-Server License
Administration to allocate and update your licenses.

while viewing the window.

of

TIP: For more information, click

tw

4. To view the results of the previous update attempts, click Event log. Click Clear event log if you no longer need the
information.
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Multi-Server License Administration window

For most users of Sage 100 Contractor, it is not necessary to allocate license across multiple servers.
If you need to allocate licenses across multiple servers, this window allows you to allocate your Sage licenses to multiple
servers. For example, this could happen if you have several corporate offices and want to use separate licenses for each office
or if you want to reserve a certain quantity of licenses for a specific group of people.
Because the Canadian Edition license controls the amount of license uses, it is the only license which is “use-counted.”
Therefore the only license that is allocated among multiple servers is the Canadian Edition license. The additional modules are
not use-based and can be used by anyone with a core Canadian Edition license and the appropriate security permission.

Example 1 - Multiple servers with specific allocations

Assume you have three servers that you want to allocate as follows:

Server
Server A
Server B
Server C

Licenses

3 Canadian Edition licenses
3 Canadian Edition licenses
4 Canadian Edition licenses

At each of the servers, you would select the Manually specify allocations for this server option in the Multi-Server License
Administration window, and select the number of licenses for that server.
If you later purchase additional Canadian Edition licenses, you must go into each server where you want the additional licenses
to be allocated and update the allocation.
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Example 2 - Multiple servers with specific allocations for all but one server
Assume you have three servers that you want to allocate as follows:

Server

Licenses

Server A

3 Canadian Edition licenses

Server B

3 Canadian Edition licenses

Server C

All remaining licenses

At servers A and B, select the Manually specify allocations for this server option in the Multi-Server License
Administration window, and select the number of licenses for each server.
At server C, select the Allocate all available licenses to this server option in the Multi-Server License Administration
window.

ar
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NOTE: In this example, it is important to select the option for server C last. If you select to automatically allocate all
available licenses on server C first, it will take all the available licenses and there will be none left to allocate to servers A
and B.

Items on this window
Item

of

If you choose this option, all licenses are allocated to this server. This is the most common
scenario. Do not choose this option if you want to allocate licenses across multiple servers.
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Allocate all available
licenses to this server
(default)

Notes

tw

If you purchase additional licenses, they will automatically be allocated to server C when the license activations are updated,
unless you manually select the licenses to go to server A or B first.

Manually specify
license allocations for
this server in the
"Uses for [server
name] column below

Select this option to allocate licenses across multiple servers. The amount of licenses you
select in the Uses for [server name] column is the amount of licenses allocated to this
server.
Displays a list of licenses available to this server, based on the products you have purchased from
Sage. When you purchase new products, the licenses for those products become available to
activate here. "Canadian Edition" refers to the basic program, exclusive of the additional modules.
The module licenses that are not part of the core Canadian Edition, but are available for purchase,
are listed here:

Module name

l

Inventory

l

Service Receivables

l

Estimating

l

Document Control

l

Equipment Management

There is also a column that shows how many Canadian Edition licenses are checked out from this
license server to local machines.

Total uses

The total number of uses that are available. This displays the total number of licenses you
have purchased.
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Item

Available uses

Uses for [server
name]

Notes
The number of uses available to this server. If some licenses have already been allocated
to a different server, it reduces the number of uses available here. For example, if you
have 10 total uses, and 2 have been allocated to another server, the available uses for this
server is 8.
The number of uses allocated to this server. You can change the number here, but you can only
add uses if there are still uses available. You can decrease uses to make more licenses available
to other servers.
If you need to have more uses available to this server, you must first relinquish licenses on one of
your other servers, or purchase additional licenses.

[OK]

Click to allocate the licenses selected in the Uses for [server name] column to this server.

[Cancel]

Click to cancel this window without making any changes.
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To open this window, open the License Administration program and on the License Information tab, click [Multi-server
licensing].
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Managing Licenses
Checking out and checking in a license use
You can use Sage 100 Contractor when your computer cannot actively communicate with the license server, by checking out a
license use from the Sage license server.
NOTE: Checking out a product license use removes it from the license server's pool of generally available license uses
and places it directly on the computer checking out the license. However, this may prevent other user access to Sage 100
Contractor, so checking out a license should only be used when necessary.

To check out a license use:
1 From the Sage 100 Contractor main window, on the File menu, click Check Out License Use.
2 Click Yes.
IMPORTANT: If you check out a license use, it remains checked out on this computer until you check in
the license using Check In License Use from the File menu.

1 From the Sage 100 Contractor main window, on the File menu, click Check In License Use.

tw

2 Click Yes.

ar
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To check in a license use:

Administering a different license server

of

In the License Administration program, you can see the number of license uses, the users who are logged on to Sage 100
Contractor, and licensing events for this license server.
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Licenses are granted to the specific computer where the licenses were initially activated. If you need to see the license uses
available on another Sage license server, you can do that in the License Administration window.

To administer a different license server:
1 Select the License Administration program.

2 From the License Administration window, click Administer Different Server.
3 Enter computer name or IP address. How?
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Troubleshooting License Issues
Troubleshooting license activation issues
Your system will automatically retrieve license information from Sage daily. The licenses give you access to the various
modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license activation server
automatically updates this information in your system.
If the server that hosts Sage 100 Contractor is unable to connect to the Sage license server for more than 10 days, you will
receive a message indicating there is a connection problem. The following are some of the more common issues that can
cause this to occur.

There is a problem with your Internet connection.
The Sage 100 Contractor server connects to the Sage license server through the Internet. Check to make sure the server's
connection to the Internet is intact.

There is a problem with your network.

ar
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Any network issues that interrupt the Internet connection (such as firewall settings) can prevent the Sage 100 Contractor
server from connecting to the Sage license server. Confirm that your firewall is configured correctly and that all network
components are operating properly.

tw

The registration information does not match.

of

The Sage client ID and Registration Name on the License Administration window must match the information on the Sage
license server. Ensure the information is entered correctly here.
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You have exceeded your license activations.

You do not have enough licenses to support everyone attempting to use Sage 100 Contractor. You may want to purchase more
licenses.
TIP: The Number of requests which exceeded use count box on the License information tab of the License
Administration window displays the number of times in the last three months that requests for licenses have exceeded
the number of licenses available.
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Chapter 7: License Use and Sage 100
Contractor
This chapter provides all the necessary details about:
l

Specifying the Sage license server

l

Managing license attributes

l

Understanding license uses

Specify Sage License Server

You can select the computer from the list of computers on your network; or

l

You can enter the IP Address or name of the computer.

of

Selecting the Sage license server computer

tw

l
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Before you can use Sage 100 Contractor with your activated license, you have to specify the computer on your network that is
the Sage license server. There are two ways to specify the Sage license server:
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One method is to select the computer running the Sage license server from the list of network computers.
NOTE: To use this method of selecting a server from the list of network computers, you must have already clicked the
appropriate link on the Specify Sage License Server window.

To select the computer running Sage license server from the list of network computers:
1 On the Select License Server window from the list of network computers, select the computer running the Sage license
server.
2 Click [OK].

Entering the IP Address or name of the computer

One method is to enter the IP Address or name of the computer running the Sage license server.

To enter the IP Address or name of the computer running the Sage license server:
1 In the text box, type the IP Address or name of the computer.
2 Click [OK].

Determining the IP Address of a computer

NOTE: If you are trying to determine the IP Address computer running the Sage license server, you must complete this
procedure on that computer.

To determine the IP Address of a computer:
1 Click Start > Run.
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2 In the Open text box, type cmd, then click [OK].
3 The \Windows\...\cmd.exe window appears.
4 At the prompt, type ipconfig.
5 For example, you might see H:\. Type ipconfig after the drive letter. When you press the Enter key, the system displays
several addresses, among which is the IP Address of the computer. You see a line similar to this:

IP Address . . . . . . . .172.20.22.142

What is an IP Address?
Every computer connected to the Internet is assigned a unique number known as an Internet Protocol (IP) address. This
numeric address of a computer on the Internet is written as a set of four numbers separated by periods (each number can range
from 0 to 255). An example of an IP Address is 123.123.4.5.

What is a server?

ar
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There are many kinds of servers. Some servers are denoted by their hardware configuration and a specialized operating
system. Other servers consist of specialized software applications running on standard computers.
Some servers are called “file servers” and may be a powerful computer dedicated to storing files and data. For example, Sage
100 Contractor company data can be stored on a file server. Any Sage 100 Contractor user on the same network as the file
server can access and store data there.
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A server can also be a software application that provides a specific kind of service to client software running on other
computers. The term server can refer to a particular piece of software, such as the Sage license server. When we refer to the
Sage license server, we are describing a computer that is running the Sage license server software.
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Chapter 8: Special Configurations - Operating
Systems and Services
This chapter contains information about special configurations for specific operating systems, such as:
Windows® 7 Professional and Windows Server 2008® R2 Standard

l

Windows Vista® and Windows Server 2008

l

Windows Server 2003®

l

Windows XP® Professional

l

Citrix® and Terminal Servers
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l
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Windows 7 Professional and Server 2008 R2 Standard Operating
Systems
Windows 7 Professional, Windows 8, and Server 2008 R2 Standard "Sleep Mode"
prevents computers from obtaining a license use
If a computer running the Windows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system is used as a
license server, when it goes into sleep mode other computers on the network can’t obtain a license.
Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never:”
1. Start > Control Panel > System and Security > Power Options.
2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

ar
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Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Windows 7 Professional and Server 2008 R2 Standard

of

tw

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 7
Professional or Server 2008 R2 Standard operating systems. If the service stops, the program displays a message advising
you to take further action to resolve this issue.

Solution for Server 2008 R2 error message about mb7.kpr file
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If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running
Windows Server 2008 R2, follow these steps to resolve the issue:
1 On the Window desktop, right-click Start, and then click Open Windows Explorer.

2 On the left side of the window, under Computer > Local Disk, right-click the \MB7 folder, and then select Properties.
3 On the MB7 Properties window, click the Security tab.

4 From the list under Group or User Names, select USERS, then click the [Edit] button.

5 On the Permissions window, select USERS again, and under Allow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.
6 On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].

Server 2008 R2 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File and printer sharing on computers running the Server 2008 R2 operating system must be
enabled. To enable file sharing, follow the instructions in the Windows Server 2008 R2 Help.
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Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008 R2
machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn’t install it
automatically.
If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following message during the
licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [OK], the installation
continues, but the services have not been installed so Sage 100 Contractor cannot open. The Sage.CRE.HostingFramework
Service will not install unless .NET 3.5.1 has been installed. If you receive the above message during installation, install .NET
Framework 3.5.1 and reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:
1 Click the Start button in the lower left corner of the display.
2 Highlight Administrative Tools and select Server Manager.

To enable .NET 3.5.1 on Windows Server 2008 R2:
1 In the Server Manager interface, select Add Features to display a list of possible features.
2 In the Select Features interface, expand .NET Framework 3.5.1 Features.

ar
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3 In the Server Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that .NET
Framework 3.5.1 is listed.

tw

3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET Framework
3.5.1 and click Next.
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5 Allow the installation process to complete and then click [Close].

of

4 In the Confirm Installation Selections interface, review the selections and then click [Install].

NOTE: Enabling .NET Framework 3.5.1 may require a reboot.
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Windows Vista and Server 2008 Operating Systems
Installation and AutoPlay
Program installations begin immediately upon inserting the CD into the CD-ROM drive if AutoPlay is set to begin
automatically. With computers running the Windows XP operating system, you can start the installation manually by using the
Start > Run > Browse command to locate and select setup.exe. With computers running the Vista and Server 2008 operating
systems, this command path has changed.
l

On Vista/Windows 7, click the Vista/Windows 7 button (left circular button at lower left of the system tray) to open a
window with the Start/Search text box at the bottom. Type setup.exe in the text box, and press the Enter key. When the
system search locates the file on the CD, double-click the file to begin the installation process.

l

On Server 2008, click Start > Run > Browse. Locate setup.exe, on the CD, and double-click the file to start the
installation.

ar
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Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license
use
If you are using a Vista or Server 2008 computer as the Sage license server and it goes into Sleep Mode, the workstations
cannot obtain a license use.

tw

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in place
of Vista or Server 2008, for example, Windows XP.

To set the Sleep Mode to Never:
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1 Start > Control Panel > System and Maintenance > Power Options.

of

Set Sleep Mode on your license server computer to Never.

2 Select Change when computer sleeps.

3 From the Put computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Vista, Windows 7, Windows 8, or Server 2008
IMPORTANT: Read this information if you are running Vista or Server 2008 operating systems on your office computers.
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Vista,
Windows 7, Windows 8, or Server 2008 operating systems. If the service stops, the program displays a message advising you
to take further action to resolve this issue.

Solution for Server 2008 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running
Windows Server 2008, follow these steps to resolve the issue:
1 On the Window desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click the MB7 folder, and then select Properties.
3 On the MB7 Properties window, click the [Security] tab.

4 From the list under Group or User Names, select USERS, then click the [Edit] button.

5 On the Permissions window, select USERS again, and under Allow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.
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6 On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].

Vista, Windows 7, and Server 2008 network configuration and TCP Remoting
Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File sharing on computers running the Vista, Windows 7, or Server 2008 operating system
must be enabled. To enable file sharing, follow the instructions in the Vista, Windows 7, or Server 2008 Help.

Vista, Windows 7, and Server 2008 and changing the Sage License Server computer
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On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the
computer from the list of computers on your network, the command may fail to generate a list of network computer
names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the
server computer in the box.
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Windows Server 2003 Operating System
Configuring Windows Server 2003 date format
It is necessary when using Windows Server 2003 to configure the date format.

To configure the Windows Server 2003 date format:
1 Click the [Start] button, point to Control Panel, then click Regional and Language Options.
2 On the Regional and Language Options dialog box, on the Regional Options tab, click the Customize... button.
3 On the Customize Regional Options dialog box, click the [Date] tab.
4 Under Short date, from the Short date format drop-down list, select the appropriate date format.
5 Click [OK].
6 To close Customize Regional Options, click [OK] again.

Setting up Windows Server 2003 for PDF and RTF printers
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In Windows Server 2003 (Standard Edition) and Windows Server 2003 (Enterprise Edition), the installation of kernel-mode
drivers is blocked by default. Before you can install Sage 100 Contractor PDF and RTF printers with Windows 2003 Server,
you have to unblock the installation of the kernel-mode drivers and edit the Group Policy.

tw

To unblock the installation and edit the Group Policy:
1 On your Windows Server desktop, click [Start], then Run....

3 In the Open: text box, type gpedit.msc, and then press Enter.
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4 The Group Policy window opens.

of

2 The Run dialog box opens.

5 In the left pane, on the Tree tab, double-click the Administrative Templates folder.
6 Then double-click the Printers folder.

7 In the right pane, in the Setting list, find and set the state of the setting for Disallow installation of printers using kernelmode drivers to Disable.

Windows XP Professional (SP2) Operating System
Configuring the Windows XP Professional date format
To configure the date format:

1 Click the [Start] button, point to Settings, and click Control Panel.

2 Double-click the Regional and Language Options icon, and click the Regional Options tab.
3 Click the Customize button and the Date tab.

4 In the Short Date Format list, select the appropriate date format.
5 Click [OK].
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Citrix and Terminal Servers
Using Citrix and Terminal Server with Sage 100 Contractor
Many people use Citrix and Terminal Server to manage remote access to their local area network (LAN). If Sage 100
Contractor is installed on the computer running Citrix or Terminal Server and on your laptop, then you may log on to the
computer running Citrix or Terminal Server with your laptop and work in Sage 100 Contractor on your LAN. This enables you to
work from home, from a job site, or from any number of other remote locations.
We recommend that you use DOS commands to change the operating mode from “execute” to “install” and then back to
“execute.” When using the DOS commands to install, you may install the Sage 100 Contractor software as you would on any
desktop or Windows server operating system that meets Sage 100 Contractor requirements.

Installing on computers running Citrix and Terminal Server using DOS commands
To install using DOS commands:
1 Click [Start], then Run.
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2 On the Run window, in the Open drop-down box, type cmd, and press the Enter key.
3 The \Windows\...\cmd.exe window appears.
4 At the prompt, type change user /install, and press the Enter key.

tw

5 This enables the install mode.

6 Install the Sage 100 Contractor software as you would on a typical workstation or Windows Server.

of

7 At the end of the installation process, choose to launch the License Administration Tool.
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8 Using the License Administration Tool window, manage your license and activate it.
9 After activation, click [Start], then [Run].

10 On the Run window, in the Open drop-down box, type cmd, and press the Enter key.
11 The \Windows\...\cmd.exe window appears.
12 At the prompt, type change user /execute.

13 This enables the execute mode, which is the default mode for running Citrix and Terminal Server.
14 Exit the Run window.
15 Restart the server.

IMPORTANT: If this message appears: “Install mode does not apply to a terminal server configured for remote
administration,” then it is not necessary to enable the install mode. You may install the Sage 100 Contractor software as
you would on a typical workstation.
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Backing Up Your Data
With any computer system, there is the possibility for failure and loss of data.
CAUTION: Use a backup method and device suitable for your business requirements. We strongly recommend that you
maintain a routine backup schedule and store your data in a safe environment that is separate from your server, preferably
off site.

Which files to back up in Sage 100 Contractor
NOTE: This topic only applies to existing Sage 100 Contractor customers.
When you back up your company data, we recommend that you back up your company financial data as well as all your
custom reports and forms. If you are running multiple Sage 100 Contractor companies, back all of them up.
When backing up data as part of the year-end close process, it is important to count the number of files and folders in your
company.
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To see the number of files and folder in a company folder, in Windows Explorer, right-click the company folder and select
Properties. On the Properties window, the General tab, look in the list for the Contains line for the number of files and folders.
Write this number down so that you can refer to it after you have made the two copies. The number of files and folders has to be
exactly the same in both the company and the backup copy.

tw

We strongly recommend that you back up:
Each company folder that contains financial data (\MB7\Your Company\)

l

The Sage 100 Contractor folder (\Users\Username\AppData\Local\Sage\Sage 100 Contractor)

l

The Report Forms folder (\MB7\Report Forms)
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IMPORTANT: When backing up your data, be sure to make a full backup and not an incremental or differential backup.
An incremental or differential backup only records alterations to the data since the last backup.
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An example of one backup method
There are various methods for backing up your data. Depending on the amount of data entry you routinely perform, you might
consider making full daily backups. It is also a good idea to regularly take one backup off the business premises or store them
in a fireproof safe. If a burglary or fire occurs, a copy of your data is safe from harm.
One reliable procedure, requiring a tape drive and multiple sets of tapes, requires you to make daily and monthly backups.

Daily Backup Process
For the daily backup process, you need 10 tapes. Label five of the tapes as Week A, with a tape designated for each weekday.
Label the other five tapes as Week B, with a tape designated for each weekday.
Start with the set of tapes labeled Week A. Monday night when you make the backup use the tape labeled Monday, on
Tuesday use the tape labeled Tuesday, and so forth. At the start of the next week, use the set of tapes labeled Week B to
make your backups. At the end of two weeks, you will have a data backup for each day. Then at the start of the third week, use
the set of tapes labeled Week A again. Over the course of a year, you will cycle through the two sets of tapes. Be sure to store
the most recent Friday backup off site.
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Monthly Backup Process

Th
ha is
s ve
be rs
en ion
re of
tir th
ed e
s

of

tw

For the monthly backups, you need a separate set of three tapes labeled Month A, Month B, and Month C respectively. Like the
weekly backups, use each tape to back up the data for a different month, cycling through each of the tapes over the course of
the year. After making a monthly backup, write the month and year on the label to help you track which tape to use next. Be
sure to remove the most recent monthly backup off site.
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Backing up your data to a CD or DVD
This topic suggests a generic way to back up your data to a CD or DVD. Backing up to a CD or DVD successfully depends on
your computer system, including hardware and software. To back up to a CD or DVD, you must have access to a CD or DVD
(Read/ Write capability), and the appropriate CD or DVD media.
When backing up data as part of the year-end close process, it is important to count the number of files and folders in your
company. To see the number of files and folder in a company folder, in Windows Explorer, right-click the company folder and
select Properties. On the Properties window, the General tab, look in the list for the Contains line for the number of files and
folders. Write this number down so that you can refer to it after you have made the two copies. The number of files and folders
have to be exactly the same in both the company and the backup copy.
IMPORTANT: If you are working across a network, you must remember to backup company folders, report folders, and
form folders that reside at the server.

To back up your data to a CD or DVD:
1 Place the CD or DVD media in the CD or DVD.
2 On your Windows desktop, right-click [Start > Explore].
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3 In Windows Explorer, locate the \Users\Username\AppData\Local\Sage\Sage 100 Contractor folder, right-click and from the
menu select [Copy].
4 Locate the CD or DVD drive, and click it.

tw

5 Then in the right-pane, right-click and select [Paste].

6 In Windows Explorer, locate the \MB7\ folder, right-click and from the menu select [Copy].

of

7 Locate the CD or DVD drive, and click it.
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8 Then in the right-pane, right-click and select [Paste].

Depending on your hardware and software, the folder will be copied to the CD or DVD media. For further information or support,
contact your CD or DVD manufacturer.
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